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Warning 

The product described herein has the potential – through misuse, inattention, or lack of understanding – to create 
conditions that could result in personal injury, damage to equipment, or damage to the product(s) described herein.  
Machinery in motion and high-power, high-current servo drives can be dangerous; potentially hazardous situations 
such as runaway motors could result in death; burning or other serious personal injury to personnel; damage to 
equipment or machinery; or economic loss if procedures aren’t followed properly.  Soft Servo Systems, Inc. assumes 
no liability for any personal injury, property damage, losses or claims arising from misapplication of its products.  In 
no event shall Soft Servo Systems, Inc. or its suppliers be liable to you or any other person for any incidental 
collateral, special or consequential damages to machines or products, including without limitation, property damage, 
damages for loss of profits, loss of customers, loss of goodwill, work stoppage, data loss, computer failure or 
malfunction claims by any party other than you, or any and all similar damages or loss even if Soft Servo Systems, 
Inc., its suppliers, or its agent has been advised of the possibility of such damages. 
 
It is therefore necessary for any and all personnel involved in the installation, maintenance, or use of these products 
to thoroughly read this pamphlet and related manuals and understand their contents.  Soft Servo Systems, Inc. stands 
ready to answer any questions or clarify any confusion related to these products in as timely a manner as possible. 
 
The selection and application of Soft Servo Systems, Inc.’s products remain the responsibility of the equipment 
designer or end user.  Soft Servo Systems, Inc. accepts no responsibility for the way its controls are incorporated 
into a machine tool or factory automation setting.  Any documentation and warnings provided by Soft Servo 
Systems, Inc. must be promptly provided to any end users. 
 
This document is based on information that was available at the time of publication.  All efforts have been made to 
ensure that this document is accurate and complete.  However, due to the widely varying uses of this product, and 
the variety of software and hardware configurations possible in connection with these uses, the information 
contained in this manual does not purport to cover every possible situation, contingency or variation in hardware or 
software configuration that could possibly arise in connection with the installation, maintenance, and use of the 
products described herein.  Soft Servo Systems, Inc. assumes no obligations of notice to holders of this document 
with respect to changes subsequently made.  Under no circumstances will Soft Servo Systems, Inc. be liable for any 
damages or injuries resulting from any defect or omission in this manual. 
 
Soft Servo Systems, Inc. makes no representation or warranty, expressed, implied, or statutory with respect to, and 
assumes no responsibility for the accuracy, completeness, sufficiency, or usefulness of the information contained 
herein.  NO IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS OF PURPOSE SHALL APPLY.  
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Important Notice 

The information contained in this manual is intended to be used only for the purposes agreed upon in the related 
contract with Soft Servo Systems, Inc.  All material contained herein is subject to restricted rights and restrictions 
set forth in the contract between the parties. 
 
These manuals contain confidential and proprietary information that is not to be shared with, nor distributed to, third 
parties by any means without the prior express, written permission of Soft Servo Systems, Inc.  No materials 
contained herein are to be duplicated or reproduced in whole or in part without the express, written permission of 
Soft Servo Systems, Inc. 
 
Although every effort and precaution has been taken in preparing this manual, the information contained herein is 
subject to change without notice.  This is because Soft Servo Systems, Inc. is constantly striving to improve its 
products.  Soft Servo Systems, Inc. assumes no responsibility for errors or omissions.   
 
All rights reserved.  Any violations of contractual agreements pertaining to the materials herein will be prosecuted to 
the full extent of the law. 
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Chapter 1:  LadderWorks PLC Product Overview 

1.1 Components Included with LadderWorks PLC 

LadderWorks™ PLC is an independent programmable logic control (PLC) package that is included with and 
integrated with all of Soft Servo Systems' SMP general motion control products and all ServoWorks CNC products. 
 
LadderWorks PLC includes: 
 

• The LadderWorks PLC Engine – a real-time soft PLC module that executes PLC sequence programs in 
binary format.  [NOTE: the LadderWorks PLC Engine only executes in conjunction with the soft Motion 
Engine of a ServoWorks CNC product or an SMP product, because the LadderWorks PLC Engine is 
seamlessly integrated with the ServoWorks CNC Engine/SMP Motion Engine into a single motion/machine 
control application.]  This PLC for machines and machine tools reads and executes the binary PLC 
sequence program file every 5 ms (or every 8 ms for ServoWorks S-100T, or some other user-defined scan 
time), decides if it needs to take any action based on these inputs or changes in these inputs, and issues 
commands to the ServoWorks CNC Engine/SMP Motion Engine or the machine, if necessary.   
 

• LadderWorks Console – a Win32 application for creating, editing, monitoring, debugging and compiling 
PLC ladder diagram (LD) sequence programs (see Note #3 on page 1-2 for compatibility requirements) 
 

• Four separate utility programs: 
 
o PLC Control Screen Utility – a stand-alone application that you can use to edit and compile your 

sequence programs in PLC Instruction List (IL) format into executable binary files, which can then be 
understood and executed by the LadderWorks PLC Engine 
 

o PLC Diagnose Utility – for verifying sequence programs with ladder diagrams (viewing ladder 
diagrams only – you cannot edit in the ladder diagram format with this utility).  [NOTE: This is a 
LadderWorks PLC legacy product that will be discontinued in the future – you shouldn’t need to use 
this, as LadderWorks Console has all of these functions and more.  However, its use is explained here 
for completeness.] 
 

o PLC Bit Pattern Utility – real-time bit pattern display for any signal address (F, G, X or Y data) 
 

o PLC Time Chart Utility – for showing the history of specified bit signals in any signal address, to aid 
in debugging PLC sequence programs 

 
NOTES:  
 

1) The LadderWorks PLC software includes the LadderWorks PLC Engine.  You must run LadderWorks PLC 
in conjunction with a ServoWorks CNC product or an SMP product in order to run the LadderWorks PLC 
Engine.  However, you can use LadderWorks Console by itself to create and edit sequence programs 
without running (executing) a ServoWorks CNC product or an SMP product. 
 

2) PLC axes are available for ServoWorks S-120M, ServoWorks S-140M, ServoWorks S-200M and SMP 
products only.  Refer to Chapter 4: LadderWorks PLC Axis Control in the LadderWorks PLC Reference 
Manual for more information. 
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1.2 LadderWorks PLC File Structure 

The LadderWorks PLC files are installed in the following folders: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-1: LadderWorks PLC File Structure 

Default sequence programs – the .lad and .mod files are 
copied during the installation of LadderWorks PLC.  The 
.bin, .div, .fig and .lst files are created during the installation 
of ServoWorks CNC and SMP products  [“SoftServo_M” files 
are provided for ServoWorks MC-Quad and the ServoWorks 
S-100M series of products; “SoftServo_T” files are provided 
for ServoWorks S-100T; and “SoftServo_SMP” files are 
provided for the SMP series of products.] 

NOTE: Customized PLC 
sequence programs can have a 
file name of your choosing, and 
can reside in any folder on your 
computer.  The LadderWorks 
PLC Engine always loads the 
most recently compiled file. 
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1.3 Overlapping Functions in Different LadderWorks PLC Components 

There are some overlapping functions between different LadderWorks PLC components, due to the inclusion of 
some legacy software that has yet to be eliminated. 

1.3.1 Overlapping Functions of LadderWorks Console and the PLC Control Screen Utility 

Both LadderWorks Console and the PLC Control Screen utility can compile PLC sequence programs, as shown: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1-2: Comparison of LadderWorks Console and the PLC Control Screen Utility 

1.3.2 Overlapping Functions of LadderWorks Console and the PLC Diagnose Utility 

Both LadderWorks Console and the PLC Diagnose utility display sequence code program execution.  However, 
while LadderWorks Console can be used to create and edit a sequence program in a ladder diagram format (as well 
as compile, generate binary code, etc.), the PLC Diagnose utility only displays sequence code program execution. 
 
You cannot use the PLC Diagnose utility to create, edit or compile a sequence program. 
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Function LadderWorks 
Console 

PLC Diagnose 
Utility 

Create ladder diagram sequence programs   

Import existing Instruction List (text format) sequence code 
programs   

View instruction list (IL) version of sequence programs   

Edit sequence programs in ladder diagram view   

Search ladder diagrams by address   

Search ladder diagrams by label   

Display sequence code program currently being executed by the 
LadderWorks PLC Engine (monitor sequence programs)   

Export sequence code programs   

Generate executable binary code from a sequence program   

Print ladder diagram sequence programs   

Force component values while monitoring sequence programs   

View I/O mapping tables and edit descriptions   

Table 1-1: Comparison of LadderWorks Console and the PLC Diagnose Utility.   

1.4 The Difference Between the Regular Version (On-Line Version) and the 
Off-Line Version of LadderWorks Console 

The regular version of LadderWorks Console can be thought of as an “on-line” version that is tightly integrated with 
the ServoWorks CNC and SMP products offered by Soft Servo Systems, Inc.  The regular version of LadderWorks 
Console has a Diagnostic Mode that displays the execution of a PLC sequence program by the LadderWorks PLC 
Engine.  The LadderWorks PLC Engine operates in the real-time subspace created by Ardence’s RTX, and is 
completely integrated with either the ServoWorks CNC Engine or the SMP Motion Engine (depending upon 
whether you are using a ServoWorks CNC product or an SMP general motion control product).  The LadderWorks 
PLC Engine and the ServoWorks CNC Engine/SMP Motion Engine perform the critical functions necessary for 
motion control, and are given the highest priority by the computer's CPU. 
 
The off-line version of LadderWorks Console can be thought of as strictly an editing application.  This version 
doesn’t support the Ardence RTX Real-Time Extension or any real-time functions; therefore, the on-line functions 
displaying real-time PLC sequence code execution are disabled.  The PLC sequence program is displayed statically.  
However, this version can be very useful for creating and editing PLC sequence code programs on another computer 
(a laptop, for instance), rather than the PC that will be controlling the motion and the machine (using either a 
ServoWorks CNC or an SMP application). 
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The off-line version of LadderWorks Console does not require a VersioBus, Panasonic Realtime Express (RTEX), 
MECHATROLINK or SSCNET adapter board to be plugged in to the host CPU.  The off-line version needs to be 
installed separately, on a separate computer than the computer on which the entire LadderWorks PLC product is 
installed.  See Section 3.4: LadderWorks Console Off-Line Version Installation Procedure. 
 
A comparison of available functions in each version follows: 
 

Function 
LadderWorks 

Console, Regular Ed. 
(ON-LINE Version) 

LadderWorks 
Console  

OFF-LINE Version 

Create and edit PLC sequence programs with ladder diagrams   

Insert basic instructions by pointing and clicking on symbols with 
easy-to-use GUI   

Insert functional commands by selecting functions from a pull-
down menu, and entering parameters (if any) in pop-up text boxes   

Meaningfully comment or label components in ladder diagrams   

Search for addresses, labels or comments within a ladder 
diagram   

View Ladder Diagrams (LD) or Instruction List (IL) format   

Print a Ladder Diagram sequence program   

View I/O mapping tables and modify descriptions   

Import existing Instruction List (text format) sequence program 
codes   

Export PLC sequence program codes in Instruction List (text 
format) according to the ladder diagram   

Generate (compile) executable binary code according the ladder 
diagram or the sequence code   

Verify and monitor PLC by viewing the execution of a sequence 
program in Diagnostic Mode – signal values are shown in different 
colors 

  

Force component values while monitoring a sequence program 
(helpful in diagnosing problems during machine setup and 
integration) 

  

Table 1-2: Comparison of LadderWorks Console Off-Line and On-Line Versions 
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1.5 Additional Documentation for LadderWorks PLC and ServoWorks CNC 
or SMP Products 

1.5.1 LadderWorks PLC Documentation Suite 

This manual will explain how to use LadderWorks PLC.  You should also refer to the other documents 
accompanying LadderWorks PLC: 
 

• LadderWorks PLC Programming Language (Basic Commands and Function Blocks)  
 

• LadderWorks PLC I/O Mapping for SMP Products 
 

• LadderWorks PLC I/O Mapping for ServoWorks MC-Quad and the ServoWorks S-100M Series 
 

• LadderWorks PLC I/O Mapping for ServoWorks S-100T 
 

• LadderWorks PLC Reference Manual  

1.5.2 Setup Documentation 

To install and set up your ServoWorks CNC or SMP system, refer to one of the following manuals: 
 

• ServoWorks CNC Setup and Integration Manual for the VersioBus Interface System 
 

• ServoWorks CNC Setup and Integration Manual for the Panasonic Realtime Express (RTEX) Interface 
System 
 

• ServoWorks CNC Setup and Integration Manual for the MECHATROLINK Interface System 
 

• SMP Installation and Setup Manual for the VersioBus Interface System 
 

• SMP Installation and Setup Manual for the Panasonic Realtime Express (RTEX)  Interface System 
 

• SMP Installation and Setup Manual for the MECHATROLINK Interface System 
 

• Quick Start Setup Guide for the Mitsubishi Interface System 

1.5.3 Additional Documentation References for PLC Axes, ATC and Inverter Spindles 

1.5.3.1 PLC Axes 
Refer to Chapter 4: LadderWorks PLC Axis Control in the LadderWorks PLC Reference Manual for information on 
setting up PLC axes. 

1.5.3.2 ATC 
For an example of using PLC to set up automated tool changes (ATC), see Section 8.5: ATC Example #3: ATC for a 
Rotary Tool Changer Using PLC, Standard G Codes, and a Customized T Code in the ServoWorks CNC Macro 
Programming Manual. 
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1.5.3.3 Inverter Spindles 
For information on setting up an inverter spindle in an all-digital interface system (by using an analog inverter, 
having S codes generate F data, and writing a PLC sequence program to generate output signals (Y data) to control 
the spindle), refer to one of the following: 
 

• For a MECHATROLINK interface system, see Section 7.6: Including an Inverter Spindle in a ServoWorks 
CNC System with a MECHATROLINK Interface System in the ServoWorks CNC Setup and Integration 
Manual for the MECHATROLINK Interface System 

 
• For an RTEX interface system, see Section 5.9: Including an Inverter Spindle in an RTEX Interface System 

in the ServoWorks CNC Setup and Integration Manual for the Panasonic Realtime Express (RTEX) 
Interface System 
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Chapter 2:  Overview of PLC in the ServoWorks CNC or SMP System 

Programmable logic control (PLC) is the process of automating the monitoring and sequence control of machines or 
machine tools.  In the ServoWorks CNC or SMP system, this process is performed by the LadderWorks PLC 
Engine, which is included as part of LadderWorks PLC.   
 
The ServoWorks CNC Engine or SMP Motion Engine controls the high-performance, multi-axis servo loops: the 
motion of the machine.  Based on its feedback loops for motion control, it may want to send a command to the 
machine to slow down, speed up, etc.  But let’s imagine that there is a door open on the machine tool.  The 
ServoWorks CNC Engine and SMP Motion Engine don’t have access to the signal that would tell it about the open 
door.  This is why the LadderWorks PLC Engine (for machine control, as opposed to motion control) is required. 
 
The LadderWorks PLC Engine has access to all the information about not only the ServoWorks CNC or SMP 
system (hardware and software), but also the machine or machine tool inputs and outputs.  The LadderWorks PLC 
Engine is the one element that has access to everything there is to know about the ServoWorks CNC or SMP system 
and the machine.  As such, it functions as the “central headquarters” for all decision-making regarding the motion 
and the machine.  It controls the sequencing of everything that happens with the machine, the servo motors, etc.   
 
The relationships between the ServoWorks CNC or SMP application software; the ServoWorks CNC Engine or 
SMP Motion Engine; the LadderWorks PLC Engine; and the machine in the VersioBus interface system are shown 
as follows (other servo interface systems are similar): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-1: Overview of the LadderWorks PLC Engine in the VersioBus Interface System 
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The LadderWorks PLC Engine executes a sequence program in a cyclical fashion.  The LadderWorks PLC Engine 
has a timer, and uses it to run the following PLC cycle every scan time (by default, the scan time is 5 msec for all 
SMP and ServoWorks CNC products except for ServoWorks S-100T, which has a default scan time of 8 msec): 
 
1) The LadderWorks PLC Engine performs a full scan of inputs from both the ServoWorks CNC Engine/SMP 

Motion Engine and inputs from the machine tool (which go through the ServoWorks CNC Engine/SMP 
Motion Engine).  In other words, it checks the status of each bit (“0” or “1”) for each F and each X input signal 
(which will be discussed later). 

 
2) The LadderWorks PLC Engine runs the executable sequence program based on these new input values.  It 

executes the program by reading and executing each command sequentially, at high speed.  The command may 
specify reading or writing inputs or outputs, or performing logical operations such as AND or OR (arithmetic 
processing). 

 
3) The LadderWorks PLC Engine sends any outputs or commands generated by the sequence program to the 

ServoWorks CNC Engine/SMP Motion Engine or to the machine (using the G and Y output signals) via the 
ServoWorks CNC Engine/SMP Motion Engine.   

 
This cycle of scan, execute sequence program, and generate outputs or commands is repeated every 5 or 8 ms.  
Every time the sequence program finishes executing, it starts again almost immediately.  This means that the 
LadderWorks PLC Engine is very responsive to any inputs or commands.   

 
For example, if a lathe operator gives a command (using the ServoWorks S-100T program) to start the spindle on a 
lathe, that command gets relayed through the S-100T CNC Engine to the LadderWorks PLC Engine.  The command 
is picked up by the LadderWorks PLC Engine (in the form of an F signal, which will be discussed later) the next 
time it scans all the inputs from the S-100T CNC Engine and the machine tool.  The LadderWorks PLC Engine then 
executes the sequence program, which will check that the door is closed on the machine tool, the collet is in 
position, etc.  (It checks these by looking at the status of X signals from the machine tool.)  If all the conditions for 
starting the spindle are met, the LadderWorks PLC Engine will issue a command to the S-100T CNC Engine, which 
is sent to the machine tool (in the form of a Y signal) to start the spindle on the lathe. 
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Chapter 3:  Installing LadderWorks PLC and the LadderWorks 
Console Off-Line Edition 

3.1 Overview 

LadderWorks PLC is included with (and installed as part of the product installation of) all ServoWorks CNC 
products and SMP general motion control products.  In most cases, you will have installed LadderWorks PLC as 
part of a package installation of a ServoWorks CNC product or an SMP product.  If you have already installed 
LadderWorks PLC as part of a ServoWorks CNC or SMP product, you don’t need to separately install anything for 
LadderWorks PLC.  See Section 3.2: LadderWorks PLC Installation as Part of a ServoWorks CNC or SMP Product 
Installation for more information.  You will need to create a customized sequence program for your machine, and 
generate binary code for execution, as explained in the rest of this manual. 
 
NOTE: The LadderWorks base components are always installed in C:\SwPLC. 
 
A separate, off-line version of LadderWorks Console is available, and can be installed on a different computer than 
the PC that is controlling the motion and the machine.  This second PC doesn’t require Ardence’s RTX Real-Time 
extension.  See Section 1.4: The Difference Between the Regular Version (On-Line Version) and the Off-Line 
Version of LadderWorks Console for more information about the off-line version of LadderWorks Console.  The 
off-line version needs to be installed separately, on a separate computer than the computer on which the entire 
LadderWorks PLC product is installed.  The installation procedure for this separate application is explained in 
Section 3.4: LadderWorks Console Off-Line Version Installation Procedure. 
 
Some customers who are using older versions of ServoWorks CNC or SMP products (that were purchased before 
the LadderWorks Console component was included in their ServoWorks CNC or SMP product) may need to install 
LadderWorks Console separately.  See Section 3.5: LadderWorks Console Regular Version Installation Procedure. 

3.2 LadderWorks PLC Installation as Part of a ServoWorks CNC or SMP 
Product Installation 

As previously noted, LadderWorks PLC is included with and automatically installed as part of the product 
installation of all the latest ServoWorks CNC products and SMP general motion control products.  If you have 
already installed LadderWorks PLC as part of a ServoWorks CNC or SMP product, you don’t need to separately 
install LadderWorks PLC.   
 
See one of the following documents for instructions on installing ServoWorks CNC products or SMP products and 
LadderWorks PLC: 
 

• ServoWorks CNC Setup and Integration Manual for the VersioBus Interface System 

• ServoWorks CNC Setup and Integration Manual for the Panasonic Realtime Express (RTEX) Interface 

System 

• ServoWorks CNC Setup and Integration Manual for the MECHATROLINK Interface System 

• SMP Installation and Setup Manual for the VersioBus Interface System 

• SMP Installation and Setup Manual for the Panasonic Realtime Express (RTEX)  Interface System 

• SMP Installation and Setup Manual for the MECHATROLINK Interface System 

• Quick Start Setup Guide for the Mitsubishi Interface System 
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Before you begin installing the LadderWorks PLC software (with ServoWorks CNC or SMP software), you must 
make sure that you meet the necessary PC hardware and operating system requirements, and have installed the 
necessary operating system patches for your OS.  [NOTE: The Microsoft Windows 2000 operating system requires 
Service Pack 1 for Ardence’s real-time extension to function properly.  No service pack is required for Windows 
XP.]  The previously listed setup manuals will guide you through this. 
 
Also, there are two known compatibility issues with Ardence's RTX (Physical Address Extension enabled, and 
incompatible HAL type), each of which can be easily resolved by changing the settings on your computer.  You 
should read the setup and installation manual for the ServoWorks CNC product or SMP product (and the appropriate 
servo interface platform) to see if either issue applies to you, and take the steps outlined to resolve the issue if 
necessary.   

3.3 Finishing Your LadderWorks PLC Setup (Compiling a PLC Sequence 
Program) 

In order to finish your setup for your ServoWorks CNC or SMP product, you must compile a customized sequence 
program specifically for your machine.  This is explained in Chapter 5: Compiling an Instruction List (IL) Sequence 
Program with the PLC Control Screen Utility and Section 7.12: Compiling a Ladder Diagram (LD) Sequence 
Program (Generating Executable Binary Code – .bin, .fig, .lad, .lst and .mod Files) for LadderWorks Console. 

3.4 LadderWorks Console Off-Line Version Installation Procedure  

The off-line version needs to be installed separately, on a separate computer than the computer on which the entire 
LadderWorks PLC product is installed.   
 
The following steps will guide you through installing your LadderWorks Console Off-Line application: 
 

1) Close all running applications. 
 

2) Place the Soft Servo Systems, Inc. CD-ROM in the CD-ROM drive.  The installation software will start 
automatically and the “Welcome to LadderWorks Console” window will appear, as shown in the following 
figure.  [NOTE: If the “Welcome to LadderWorks Console” window doesn’t appear automatically, click on 
LadderWorks_Install.exe, and a window similar to the following will appear.] 

        

You must have installed Ardence RTX prior to installing LadderWorks PLC, or 
installation of LadderWorks PLC will not be possible.  You must check for 
known compatibility issues with Ardence RTX, and resolve before installing 
RTX. 

                                         CAUTION ! 
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Figure 3-1: Welcome to LadderWorks Console Window – Off-Line Edition 

3) In the “Welcome to LadderWorks Console” window (above), click on the “Read Me” button.  This will 
open up a Notepad file with installation information.  We recommend that you print out this file for 
reference during the installation procedure and for future reference.  Exit the Notepad application to 
continue. 
 

4) In the “Welcome to LadderWorks Console” window (Figure 3-1), click on the “LadderWorks Console Off-
Line Edition” button – the LadderWorks Console off-line edition will install automatically, then the 
following window will appear: 

 

 
Figure 3-2: LadderWorks Install Dialog Box 

5) You must install the DAO package for LadderWorks Console.  Click the “OK” button to start the 
installation, and the following dialog box will appear: 

 

 
Figure 3-3: Setup Dialog Box 
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6) When the InstallShield Wizard has been set up (which happens automatically), the following window will 
appear: 

 

 
Figure 3-4: Welcome to the DAO Setup Window 

7) Click the “Next” button, and the following window will appear: 
 

 
Figure 3-5: Select Components Window (1 of 2) 

8) Click the “Next” button without changing any settings (leave both “Jet 3.5” and “ODBC Direct” checked), 
and the following window will appear: 

 



 LADDERWORKS PLC USER’S MANUAL 
 Chapter 3:  Installing LadderWorks PLC and the LadderWorks Console Off-Line Edition 

_____________________________________________________________________________________ 
3-5 

 
Figure 3-6: Select Components Window (2 of 2) 

9) Click the “Next” button without changing any settings (select all the optional formats), and the DAO 
software will automatically start installing.  The following dialog box will be displayed to show the 
progress of DAO installation: 

 

 
Figure 3-7: Installation Progress Dialog Box 

10) When the DAO software has been successfully installed, the following dialog box will appear: 
 

 
Figure 3-8: Information Dialog Box 

11) Click the “OK” button to finish the LadderWorks Console and DAO package installation. 
 

12) Click the “Exit” button in the “Welcome to LadderWorks Console” window (Figure 3-1) to close that 
window.   
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3.5 LadderWorks Console Regular Version Installation Procedure 

If you are using a ServoWorks CNC or SMP product that you purchased before the LadderWorks Console 
component was included in that product, you will need to install LadderWorks Console separately.   
 
The procedure for the separate installation of the regular version of LadderWorks Console is the same as the 
procedure for installing the off-line version of LadderWorks Console, except for the text in the “Welcome to 
LadderWorks Console” screen and the label on the “LadderWorks Console” button.  See Section 3.4: LadderWorks 
Console Off-Line Version Installation Procedure.  The “Welcome to LadderWorks Console” screen for the separate 
installer for the regular version of LadderWorks Console is shown in the following figure: 
 

 

Figure 3-9: Welcome to LadderWorks Console Window – Regular Edition
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Chapter 4:  Setting Up a Customized Sequence Program 

4.1 Description of the Sequence Program and Other PLC Files 

A sequence program is a program that is written in PLC code, in Instruction List (IL) text format, or in Ladder 
Diagram (LD) format.  This sequence program tells the LadderWorks PLC Engine how to control the machine or 
machine tool, and how to control the computer numerical control (ServoWorks CNC Engine/SMP Motion Engine).   
 
The PLC language used by LadderWorks PLC and described in this manual is compatible with Fanuc’s PLC ladder 
logic. 
 
Because each machine is different, you will need to write a unique PLC sequence program for each machine setup, 
although sequence programs can be reused for machines that are the exact same make and model.  The specifics of 
using LadderWorks Console to create a unique PLC sequence program are explained in Chapter 7: Using 
LadderWorks Console.  The file types of sequence programs are explained in this chapter. 

4.2 Sequence Program File Types 

4.2.1 Overview 

The actual sequence program (the “.lad” or “.ldv” file) is one of a series of files with the same name, but different 
file extensions, located by default in the folder “C:\SwPLC\Ladder.”  Some of these files are automatically 
generated when you compile your sequence program.   
 
If you are creating a sequence program in IL format, you must create “.lad” and “.mod” files, and compile them to 
create the rest of the required files.  The “.lad” and the “.mod” files must reside in the same folder. 
 
If you are creating a sequence program with LadderWorks Console, you should create and save an “.ldv” file, and 
compile it to create the rest of the required files. 
 
NOTE:  LadderWorks PLC includes default “.lad” and “.mod” sequence program files that are precompiled during 
your LadderWorks PLC installation to create the executable binary format and all the other required files, so that 
you can turn on (start) your ServoWorks CNC or SMP product even before you create and compile your customized 
sequence program. 

4.2.2 Creating .lad Files in Text (IL) Format 

A sequence program (the “.lad” or “.ldv” file) is a way of expressing sequential logic to control a machine.  The 
PLC Control Screen utility takes a representation of the system requirements (the PLC sequence program, in 
Instruction List Format) and converts it to an executable binary format so that it can be executed by the 
LadderWorks PLC Engine.  Because you will most likely be creating sequence programs with LadderWorks 
Console, it will probably be more convenient to compile your sequence program with LadderWorks Console. 
 
One way to create a sequence program is to write PLC code in Instruction List (IL) Format using a text editor.  Any 
text editor or word processor can be used to create a sequence program.  That text file should then be saved as a .lad 
file – the sequence program must be a text file with a “.lad” extension.  The default .lad file that comes with 
LadderWorks PLC needs to be modified or replaced with a sequence program that is customized for your machine.   
 
A .lad file must have “%@3” for the first line, and “%” for the last line.  Comments can be included in sequence 
programs by beginning a line with “;” or “//”.  Comments must be on separate lines.  Each command should be on a 
separate line. 
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NOTE: Any lines starting with tabs in a sequence program are ignored. 
 
You can view the PLC code of your sequence program (that you wrote in IL text format) in a ladder diagram format 
to verify and debug your sequence program using LadderWorks Console (described in Chapter 7: Using 
LadderWorks Console) or using the PLC Diagnose utility (described in Chapter 10: Verifying Sequence Programs 
Using the LadderWorks PLC Diagnose Utility). 
 
We strongly recommend that you begin with our default sequence program, included in LadderWorks PLC.  A 
typical .lad file (which demonstrates how to correctly handle the HandWheel E-STOP) is shown as follows, and 
continues on the next 2 pages: 
 

%@3 
 
// E-Stop using HandWheel E-Stop input 
RD X0.0 
WRT     G8.4 
 
// Handwheel axis selection 
RD X0.1 
OR X0.3 
WRT G41.0 
WRT G18.0 
 
RD X0.2 
OR X0.3 
WRT G41.1 
WRT G18.1 
 
RD X0.4 
WRT G41.2 
WRT G18.2 
 
// Handwheel multiple 
RD X1.0 
WRT G19.4 
RD X1.1 
WRT G19.5 
 
 

Figure 4-1: Typical .lad File: SoftServo_0 (1 of 3) 
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//////////////////////////////////////////////////////////////// 
// The following three sections work for M30 program restart  // 
// after rewind. If you would like to have this function,     // 
// Please enable these three sections by removing the "//"    // 
// comment signals and re-compile.                            // 
//////////////////////////////////////////////////////////////// 
 
// Cycle Start Rising Edge Relay 
RD F0.5 
AND.NOT R1.5 
WRT R1.6 
 
RD F0.5 
WRT R1.5 
 
// M30 Falling Edge Relay 
RD.NOT F9.4 
AND R1.0 
RD.STK R1.4 
AND.NOT R1.6 
OR.STK 
WRT R1.4 
RD F9.4 
WRT R1.0 
 
// Cycle start 
RD R1.4 
//TMR 1  // With Timer delay 
AND.NOT F0.5 
WRT G7.2 
 
// Feed hold (M00, M01) 
RD F9.6 
AND F2.5 
WRT R2.0 
 
RD F9.7 
AND F7.0 
OR R2.0 
WRT G8.5 
 

 

Figure 4-2: Typical .lad File: SoftServo_0.lad (2 of 3)  
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// MFIN (M00, M01, M02, M03, M04, M05, M30) 
RD F9.7 
OR F9.6 
OR F9.5 
OR F9.4 
WRT R0.0 
 
RD F7.0 
AND R0.0 
WRT R0.2 
 
RD.NOT F7.0 
AND R0.1 
WRT R0.3 
 
RD R0.2 
AND.NOT R0.3 
WRT G5.0 
 
RD R0.0 
WRT R0.1 
 
// SFIN (By S Strobe) 
RD F7.2 
WRT G5.2 
 
// TFIN (By T Strobe) 
RD F7.3 
WRT G5.3 
 
% 
 

Figure 4-3: Typical .lad File: SoftServo_0.lad (3 of 3)  
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4.2.3 .mod Files 

The “.mod” is a text file that you must create or verify with a “.mod” extension that tells LadderWorks PLC which 
files to reference.  Specifically, the “.mod” file refers to the “.lad” file, and tells the compiler to compile the “.lad” 
file and generate a series of files with the same name as the “.lad” file, but with different extensions.  It is the “.mod” 
file that is actually compiled when you compile your sequence program.  The .mod file will always be one line.   
 
The “.lad” and the “.mod” files must reside in the same folder. 
 
The default .mod file is shown as follows: 
 
 

SoftServo_0 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-4: Example .mod File: SoftServo_0.mod 

In this case, the name of the series of files will all be named “SoftServo_0,” but will have different extensions: 
SoftServo_0.lad, SoftServo_0.bin, SoftServo_0.div, SoftServo_0.fig and SoftServo_0.lst. 

4.2.4 Creating .lad and .mod Files From a Ladder Diagram Format Sequence Program 

You can create .lad and .mod sequence program files in Instruction List (text format) from ladder diagram format 
sequence programs with LadderWorks Console.  See Section 7.11: Exporting PLC Sequence Program Code in 
Instruction List (IL) Format (.mod and .lad Files) for more information. 
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4.2.5 .bin Files, .div Files, .fig Files and .lst Files 

These files are automatically generated in the same folder as the .lad and .mod files when you compile the .mod file. 
 
The .bin file is the binary file for execution.  The .div file contains the module divide table.  The .fig table is the file 
used for real-time ladder diagram display (for LadderWorks Console or the PLC Diagnose utility).  The .lst file has 
the assembly-code format and machine codes. 

4.2.6 .ldv Files 

The .ldv file type is a graphical file type, containing ladder diagram format graphical information that is used by 
LadderWorks Console.  This is the main format used by LadderWorks Console. 

4.2.7 What is the Difference Between the .lad and .ldv Files? 

The .lad and .ldv file types are inter-compatible formats, summarized as follows: 
 

File Type Data Type PLC Format 

.lad text Instruction List (IL) 

.ldv graphical Ladder Diagram (LD) 

Table 4-1: Comparison of .lad and .ldv Files 

The same PLC sequence (logic) program can exist in both IL and LD formats. 

4.3 Overview of File Structure 

In order to control the machine using PLC, the sequence program files will be automatically set up according to one 
of the following two figures, depending upon whether or not you are using LadderWorks Console. 
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Figure 4-5: Sequence Program Setup Procedure with the LadderWorks Utility Tools (and Without 
LadderWorks Console)
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Figure 4-6: Sequence Program Setup Procedure with LadderWorks Console) 
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4.4 Coding Convention 

PLC commands make up your sequence program and represent the specifications of your machine.  Writing PLC 
commands in Instruction List (IL) format or creating PLC commands in Ladder Diagram (LD) format is called 
“coding.”  An example of PLC code and the corresponding ladder diagram is shown in Figures 4-7 and 4-8, and 
Table 4-1.  
 

%@3 
 
// E-Stop using HandWheel E-Stop input 
RD X0.0 
WRT   G8.4 
 
 
// Handwheel axis selection 
RD X0.1 
OR X0.3 
WRT G41.0 
WRT G18.0 
 
RD X0.2 
OR X0.3 
WRT G41.1 
WRT G18.1 
 
RD X0.4 
WRT G41.2 
WRT G18.2 

 

Figure 4-7: PLC Coding Example – Instruction List Format (.lad) 
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Step 
No. Command Address 

No. 
Bit 
No. Description

1 RD X0 . 0 HW_ESTP 

2 WRT G8 . 4 *ESP 

3 RD X0 . 1  HW_1 

4 OR X0 . 3 HW_3 

5 WRT G41 . 0 HS1IA 

6 WRT G18 . 0 HS1A 

7 RD X0 . 2 HW_2 

8 OR X0 . 3 HW_3 

9 WRT G41 . 1 HS1IB 

10 WRT G18 . 1 HW1B 

11 RD X0 . 4 HW_4 

12 WRT G41 . 2 HS1IC 

13 WRT G18 . 2 HS1C 

Table 4-2: PLC Coding Example – Program Breakdown 



 LADDERWORKS PLC USER’S MANUAL 
 Chapter 4:  Setting Up A Customized Sequence Program 

_____________________________________________________________________________________ 
4-11 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-8: PLC Coding Example – Ladder Diagram Format (.ldv) 

4.5 Coding Limitation – Horizontal Ladder Length of a PLC Sequence 
Program 

There is a limitation to the horizontal ladder length in a PLC sequence program: the ladder length cannot exceed 8 
addresses.  This problem can occur when a series of AND-type operations are repeated eight or more times on a 
single coil, or when a certain number of AND-type operations are combined with certain functions.  
 
Two examples follow:  
 
 
 RD R0.0 RD R0.0 
 AND R0.1 AND R0.1 
 AND R0.2 AND R0.2 
 AND R0.3 AND R0.3 
 AND R0.4 AND R0.4 
 AND R0.5 AND R0.5 
 AND R0.6 AND R0.6 
 AND R0.7 AND R0.7 
 WRT R2.0 AND R1.0 
  WRT R2.0 
 
 THIS COMPILES THIS DOES NOT COMPILE 

Figure 4-9: Example #1 of Horizontal Ladder Length Limitation 
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 RD R0.0 RD R0.0 
 AND R0.1 AND R0.1 
 AND R0.2 AND R0.2 
 AND R0.3 AND R0.3 
 TMR 1 AND R0.4 
 WRT R1.0 TMR 1 
  WRT R1.0 
   
 
 THIS COMPILES THIS DOES NOT COMPILE 

Figure 4-10: Example #2 of Horizontal Ladder Length Limitation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

        

YOU MUST BE AWARE OF THIS CODING LIMITATION.  IF YOU 
EXCEED THE LIMITATION OF 8 HORIZONTAL ADDRESSES, YOUR PLC 
SEQUENCE PROGRAM WILL EITHER NOT COMPILE OR WILL NOT 
LOAD CORRECTLY. 

                                         CAUTION ! 
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Chapter 5:  Compiling an Instruction List (IL) Sequence Program with 
the PLC Control Screen Utility 

5.1 Overview 

In order to finish your machine setup, you must create and compile a sequence program for your machine/machine 
tool.  In order for you to use your ServoWorks CNC or SMP product immediately, and start setting up your 
parameters and tuning, default .lad and .mod sequence program files were copied over and precompiled 
automatically during the software installation for all ServoWorks CNC and SMP products.  Of course, before you 
use your ServoWorks CNC or SMP product to correctly operate your machine tool or machine, you will need to 
create a customized sequence program specifically for your machine tool or machine setup, rather than just using the 
default sequence program.   
 
There are two ways to create a sequence program: 
 

1) You can create a sequence program in text (IL) format using the Notepad application, or any word 
processing application. 
 

2) You can create a sequence program in ladder diagram (LD) format with LadderWorks Console, as 
explained in Chapter 7: Using LadderWorks Console.  [NOTE: You can then use LadderWorks Console to 
create a text format from this ladder diagram format if you want.] 

 
This chapter explains how to compile a text format sequence program (.lad file and .mod file) using the PLC Control 
Screen Utility.  Compiling a ladder diagram format sequence program using LadderWorks Console is explained in 
Section 7.12: Compiling a Ladder Diagram (LD) Sequence Program (Generating Executable Binary Code – .bin, 
.fig, .lad, .lst and .mod Files).  Either method of compiling a sequence program is acceptable. 

5.2 Compiling an Instruction List (IL) Sequence Program with the PLC 
Control Screen Utility 

 
 
 
 
 
 
 
 

Figure 5-1: Compiling a Sequence Program with the PLC Control Screen Utility 

To use the PLC Control Screen utility to compile a sequence program, your sequence program must be in .lad 
format, and you must also have a .mod file.  The .lad and .mod files must reside in the same folder.  See Section 4.2: 
Sequence Program File Types for more information. 
 
The following steps will guide you through compiling your sequence program: 
 

1) Start the PLC Control Screen utility by double clicking on the   file in the 
C:\SwPLC\Utility folder.   
 
If the status of ladder logic is “RUN,” you will see the PLC Control Screen window shown in the following 
figure: 

.mod file 
 

.lad file 

.bin file  
 
.div file 
 
.fig file 
 
.lst file 
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Figure 5-2: PLC Control Screen Window for “RUN” Status 

If the status of ladder logic is “STOP,”  you will see the PLC Control Screen window shown in the 
following figure: 
 

 
Figure 5-3: PLC Control Screen Window for “STOP” Status 

2) The PLC status must be “STOP.”  If the status is “RUN,” you must click on the “PLC stop” button, and the 
ladder logic process will stop immediately.   

 

 

 

 

 
 

        

THE EMERGENCY STOP FOR YOUR MACHINE MUST BE ACTIVATED 
BEFORE YOU STOP THE PLC LADDER LOGIC PROCESS BY CLICKING 
ON THE “PLC STOP” BUTTON. 

                                         CAUTION ! 



 LADDERWORKS PLC USER’S MANUAL 
 Chapter 5: Compiling an Instruction List Sequence Program with the PLC Control Screen Utility 

_____________________________________________________________________________________ 
5-3 

 
3) Click on the “Compile” button, and you will see the following window: 

 
Figure 5-4: PLC Ladder Compiler Screen 

4) In the above window, the .mod file you want to compile should be listed in the “Module definite file name” 
text box.   
 
NOTE: The default sequence program is named “SoftServo_M.mod” (for ServoWorks MC-Quad and the 
ServoWorks S-100M series of products); “SoftServo_T.mod” (for ServoWorks S-100T); or 
“SoftServo_SMP.mod” (for the SMP series of products) in the “C:\SwPLC\Ladder” folder.  
 

5) To select a different .mod file, click the “Refer” button.  You will see the “Select Module Definition File” 
window appear, as shown: 

 

 
Figure 5-5: Select Module Definition Window 

6) Browse to the folder where the .mod file you have created for your customized sequence program resides.  
[The default sequence program SoftServo_M.mod, SoftServo_T.mod or SoftServo_SMP.mod file resides 
in the “C:\SwPLC\Ladder” folder (C:\SwPLC\Ladder\SoftServo_M.mod)].  Click the “Open” button once 
you have selected the correct file.  You will see the PLC Ladder Compiler Screen again. 
 

7) Click on the “Compile” button to start the compiling process.  When it is finished successfully, you will see 
the following dialog box: 
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Figure 5-6: Compile Finish Dialog Box 

8) Click the “OK” button and the compilation of your sequence program will be complete.   
 

9) To exit the PLC Control Screen utility, click the “Cancel” button in the PLC Ladder Compiler Screen, and 
then click the exit button (  ) in the upper right hand corner of the PLC Control Screen. 
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Chapter 6:  Using the PLC Control Screen Utility to Set Up Tables for 
PLC 

6.1 Starting the PLC Control Screen Utility 

The PLC Control Screen utility enables you to set up the timer, the counters, and table setup data, as well as to start, 
stop and compile ladder logic.  Setting up tables for your PLC is necessary for using LadderWorks PLC for your 
machine.  [NOTE: Setting up tables for your PLC cannot be done with LadderWorks Console – YOU MUST USE 
THE PLC CONTROL SCREEN UTILITY, explained in this chapter.] 
 
Start the PLC Control Screen utility by double clicking on the   file in C:\SwPLC\Utility.   
 
If the status of ladder logic is “RUN,” you will see the PLC Control Screen window shown in the following figure: 

 
Figure 6-1: PLC Control Screen Window for “RUN” Status 

If the status of ladder logic is “STOP,”  you will see the PLC Control Screen window shown in the following figure: 
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Figure 6-2: PLC Control Screen Window for “STOP” Status 

The first time you run the PLC Control Screen utility, the “K edit,” “T edit” and “C edit” buttons may be disabled.  
If these three buttons are ever disabled, you can enable them by compiling the SwPLC table – see Section 6.2: PLC 
Tables for Input/Output Declaration, and follow the procedure described in this section. 
 
To exit the PLC Control Screen utility at any time, click on the    button in the upper right hand corner. 

6.2 PLC Tables for Input/Output Declaration 

One of the steps necessary to convert a sequence program into machine language is I/O declaration.  After you 
define the specifications (commands) for the sequence program, you need to create the interface settings.  In the I/O 
interface setup table, you assign each I/O signal a name (under six characters), depending on the signal type.   
 
LadderWorks PLC includes a default Sw_PLC.tbl file with all the default I/O mapping of X, Y, F and G addresses, 
which upon installation sets up an initial set of default X, Y, F, G, K, T and C address settings into the registry files 
of your computer.  See Chapter 2: Memory Addresses in the LadderWorks PLC Reference Manual for more 
information. 
 
If you modify the Sw_PLC.tbl file, or the “K edit,” “T edit” and “C edit” buttons in the PLC Control Screen utility 
are disabled, you will need to compile your tables for PLC again, as explained in the following steps: 
 

1) Click the “Table setting” button on the PLC Control Screen, and the following window will appear: 
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Figure 6-3: PLC Table Setting Screen 

2) Make sure the I/O interface setup table file shown in the “Table file” text box is the file you want.  If you 
want to use a different file for your table, click on the “Refer” button and browse to the file you do want to 
use as the comment setup table file for the PLC Diagnose utility. 

 

3) Select either “BINARY” or “BCD” in the “C” frame, to select whether the data in the counter addresses 
should be stored in binary or BCD.  [See Section 3.8: Numerical Data Examples in the LadderWorks PLC 
Programming Language (Basic Commands and Function Blocks) manual for more information.] 

 

4) Click on the “Execute” button.  The setup process of putting I/O mapping information and default keep 
relay, timer and counter addresses into your PC’s registry, will start automatically.  When the process has 
finished successfully, you will see the following dialog box: 

 
Figure 6-4: PLC Table Setting Screen Dialog Box 

Your tables are now successfully set up (incorporated into the PLC environment – in the registry files of 
your computer).  Click “Cancel” to close the PLC Table Setting Screen. 
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6.3 Editing Your Keep Relay for PLC 

To edit the default settings of the keep relay for PLC, click the “K edit” button in the PLC Control Screen utility, 
and the following window will appear: 

 

 
Figure 6-5: Edit Keep Relay Window 

If the “K edit” button is disabled, you need to compile the SwPLC table – Section 6.2: PLC Tables for Input/Output 
Declaration, and follow the procedure described in this section. 
 
For each keep relay address, you can select “ON” or “OFF” for the status of the keep relay. 
 
To set all the keep relays back to “OFF,” click on the “Reload” button.   
 
You can use the “Back” and “Forward” buttons to scroll through the keep relays.  Clicking on the “First” button 
displays the first page of keep relays, while clicking on the “Last” button displays the last page of keep relays.  If 
you click on the “Page” button, a Page Selection Window will appear (as shown in the following figure), and you 
can scroll through all pages of keep relays, and select one by clicking on the “OK” button. 
 

 
Figure 6-6: Page Selection Window 

When you have finished setting up your keep relays, click on the “OK” button to save the settings. 
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6.4 Editing the Timer for PLC 

To edit the default settings of the timer for PLC, click the “T edit” button in the PLC Control Screen utility, and the 
following window will appear: 

 

 
Figure 6-7: Edit Timer Window 

If the “T edit” button is disabled, you need to compile the SwPLC table – see Section 6.2: PLC Tables for 
Input/Output Declaration, and follow the procedure described in this section. 
 
For each timer, you can specify the time in milliseconds. 
 
To set all the timers back to “0,” click on the “Reload” button.   
 
You can use the “Back” and “Forward” buttons to scroll through the timers.  Clicking on the “First” button displays 
the first page of timers, while clicking on the “Last” button displays the last page of timers.  If you click on the 
“Page” button, a Page Selection Window will appear (similar to Figure 6-6), and you can scroll through all pages of 
timers, and select one by clicking on the “OK” button. 
 
When you have finished setting up your timers, click on the “OK” button to save the settings. 
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6.5 Editing the Counters for PLC 

These counter values are used by the CTR counter functional command (SUB5) and the CTRC counter functional 
command (SUB55).  Each counter has 4 bytes: 2 bytes for a preset value, and 2 bytes for a count-up value. 
 
To edit the default settings of the counters for PLC, click the “C edit” button in the PLC Control Screen utility, and 
the following window will appear: 

 

 
Figure 6-8: Edit Counter Window 

If the “C edit” button is disabled, you need to compile the SwPLC table – see Section 6.2: PLC Tables for 
Input/Output Declaration, and follow the procedure described in this section. 
 
For each counter, you can specify the number of counts. 
 
To set all the counters back to “0,” click on the “Reload” button.   
 
You can use the “Back” and “Forward” buttons to scroll through the counters.  Clicking on the “First” button 
displays the first page of counters, while clicking on the “Last” button displays the last page of counters.  If you 
click on the “Page” button, a Page Selection Window will appear (similar to Figure 6-6), and you can scroll through 
all pages of counters, and select one by clicking on the “OK” button. 
 
When you have finished setting up your counters, click on the “OK” button to save the settings. 
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6.6 Setting Up and Editing Data Table Addresses 

6.6.1 Overview 

D data in the D address settings are stored in the registry files of the computer.  [See Section 2.9: Data Addresses 
(D) in the LadderWorks PLC Reference Manual for more information.] 
 
There are two ways to enter data in the data table: 
 

1) Use the PLC Control Screen utility to enter data manually. 
 

2) Read and write into the data table using a sequence program.  Create a sequence program file to define data 
using the NUME (constant declaration) or NUMEB (binary constant declaration) functional commands.  
When the sequence program is compiled, LadderWorks PLC will populate the data table.  

6.6.2 Using the PLC Control Screen to Enter Data in the Data Table 

6.6.2.1 Adding or Deleting Data  
To create a default data table, click the “D table” button in the PLC Control Screen utility, and the following 
window will appear: 

 

 
Figure 6-9: PLC Data Table Setting Screen 

Enter the address, data type, data size and comment in the “Edit table to be added” frame, and use the “<- Add –” 
button to add data.  Or, select data from the Table list box, and use the “-Delete->” button to delete data. 

6.6.2.2 Editing Data 
 
To edit the data table (without adding or deleting data items), click the “D edit” button in the PLC Control Screen 
utility (Figure 6-2), and the following window will appear: 
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Figure 6-10: PLC Edit Data Table Screen 

To set all data back to “0,” click on the “Reload” button.   
 
You can use the “Back” and “Forward” buttons to scroll through the data.  Clicking on the “First” button displays 
the first page of data, while clicking on the “Last” button displays the last page of data.  If you click on the “Page” 
button, a Page Selection Window will appear (similar to Figure 6-6), and you can scroll through all pages of data, 
and select one by clicking on the “OK” button. 
 
When you have finished setting up your data, click on the “OK” button to save the settings. 
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Chapter 7:  Setting Up Customized PLC Alarm Messages 

7.1 Overview 

You can customize PLC alarm messages to be displayed in the GUI of ServoWorks CNC and SMP general motion 
control applications.  There are two steps to customizing PLC alarm messages for your PLC sequence program: 
 

1) Modify the “AlarmMsg.dat” file 
 

2) Modify the PLC sequence program 

7.2 Modifying the “AlarmMsg.dat” file 

There is a default “AlarmMsg.dat” file automatically installed in the directory “C:\Program 
Files\SoftServo\application\ini”, where “application” varies depending upon the Soft Servo Systems application you 
are running (“SMP850, MC-Quad, S-140M, etc.). 
 
You can double-click to edit this file in Notepad.  The contents of the default (unmodified) file are shown in the 
following figure: 
 

 

Figure 7-1: Default AlarmMsg.dat File 

“A00” indicates the alarm number.  “Sample alarm message 0” indicates the message to be displayed when this 
alarm is activated.  There are 100 bytes (A00 through A99) in the A address space.  Each byte holds 8 possible 
alarms, for a total of 800 possible alarms: A00.0 through A99.7. 

7.3 Modifying the PLC Sequence Program to Write to the “A” Address 
Space 

You must modify your customized PLC sequence program to include the line “WRT A00.0” (or similar) for each 
situation in which you want to display an alarm message, in which “A00.0” in the sequence program corresponds to 
alarm message “000” to be displayed. 
 
The relationship between the alarm numbers used in the AlarmMsg.dat text file and the corresponding alarm A 
addresses that should be used in the PLC sequence program are shown in the following table: 
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A addresses in the PLC 

sequence program 
Alarm numbers in the 

AlarmMsg.dat file 

A00.0 (A0.0) A000 (A00) 

A00.1 (A0.1) A001 (A01) 

A00.2 (A0.2) A002 (A02) 

A00.3 (A0.3) A003 (A03) 

A00.4 (A0.4) A004 (A04) 

A00.5 (A0.5) A005 (A04) 

A00.6 (A0.6) A006 (A06) 

A00.7 (A0.7) A007 (A07) 

A01.0 (A1.0) A008 (A08) 

A01.1 (A1.1) A009 (A09) 

. 

. 

. 

. 

. 

. 

. 

. 

A99.7  A799  

Table 7-1: Address Map for PLC Sequence Program A Addresses and Alarm Numbers in the AlarmMsg.dat 
File 

NOTE: “A21.0” and “A021.0” will be interpreted the same in the PLC sequence program, as will “A0.0” and 
“A00.0” and “A000.0” in the PLC sequence program. 
 
For the default AlarmMsg.dat file shown in Figure 7-1, the “WRT A00.0” line would cause the following alarm to 
be displayed: 
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Figure 7-2: Alarm Message Display – 1 of 2 
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7.4 Unspecified PLC Alarms 

When an alarm is unspecified, it displays as “Unspecified alarm,” as shown in the following screen shot: 
 

 

Figure 7-3: Alarm Message Display – 2 of 2 
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Chapter 8:  Using LadderWorks Console 

8.1 What You Can Do With LadderWorks Console 

LadderWorks Console is a Graphical User Interface (GUI)-based software system for developing PLC sequence 
programs.  
 
With LadderWorks Console, you can: 
 

• Create and edit PLC sequence programs with ladder diagrams  
 

• Insert basic instructions by pointing and clicking on symbols with easy-to-use GUI 
 

• Insert functional commands by selecting functions from a pull-down menu, and entering parameters (if 
any) in pop-up text boxes 
 

• Meaningfully comment or label components in ladder diagrams 
 

• Search for addresses or labels within a ladder diagram 
 

• View Ladder Diagram (LD) or Instruction List (IL) format 
 

• Print a Ladder Diagram sequence program 
 

• View I/O mapping tables and modify address descriptions (with the Register Address map) 
 

• Import existing Instruction List (text format) sequence programs 
 
• Export PLC sequence programs in Instruction List (text format) according to the ladder diagram 
 
• Generate (compile) executable binary code according to the ladder diagram sequence code 

 
• Verify and monitor PLC by viewing the execution of sequence programs in Diagnostic Mode – signal 

values are shown with different colors 
 

• Force component values while monitoring sequence programs (helpful in diagnosing problems during 
machine setup and integration) 

 
All of these functions are explained in this chapter.  All the screen shots in this chapter are taken on a Windows XP 
computer; the operating procedure in Windows 2000 is very similar. 
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8.2 Starting LadderWorks Console 

Start LadderWorks Console by double clicking the    icon on the desktop, or by double clicking 
 in the directory “C:\Program Files\SoftServo\LadderWorks\LadderWorksConsole.exe”.  

The application window will appear as shown in the following figure: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-1: LadderWorks Console Main Window 

8.3 The Ladder Diagram Format (Interpreting the Ladder Diagram)  

8.3.1 Overview 

The ladder diagram is interpreted by you.  There is a set of consistent symbols described below.  The ladder diagram 
will contain addresses, signal names, and comments. 

 

Main toolbar 
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8.3.2 Addresses 

An address is composed of an address number and a bit number, as described in the following figure: 
 

 
 
 
 
 
 
 
 
 
 

Figure 8-2: Format for an Address in a Ladder Diagram 

There is always a letter of the alphabet in front of the address number to indicate the kind of signal it is.  See the 
following table for letters used and their meanings.  

 

Signal Letter Signal Description 

X Input signal from the machine to the LadderWorks PLC Engine  
(MT → PLC) 

Y Output signal from the LadderWorks PLC Engine to the machine  
(PLC → MT) 

F Input signal from the ServoWorks CNC Engine / SMP Motion Engine 
(NC) to the LadderWorks PLC Engine (NC → PLC) 

G Output signal from the LadderWorks PLC Engine to the ServoWorks 
CNC Engine / SMP Motion Engine (NC) (PLC → NC) 

R Internal Relay 

A Requesting Message Display 

C Counter 

K Keep Relay 

D Data Table 

T Variable Timer 

Table 8-1: Signal Letters and Their Meanings 

8.3.3 Signal Names 

All signal names will be at most 8 characters.  Each character can be a letter, a number, or a special symbol.  

R 202.2 

Bit number (0~7) 

Address number (up to 4 digits following a letter 
– the address ranges vary for each signal) 

Signal letter 
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8.3.4 Commenting 

Up to 30 characters may be displayed to comment each relay coil and signal in the sequence program.  

8.3.5 Symbols 

The ladder diagram utilizes the following symbols: 
 

 

Symbol Description 

 
RD (for an internal variable, an input signal from the 
ServoWorks CNC Engine/ SMP Motion Engine, or an input 
signal from the machine tool) 

 
RD.NOT (for an internal variable, an input signal from the 
ServoWorks CNC Engine/ SMP Motion Engine, or an input 
signal from the machine tool) 

 
WRT (for a relay coil for an internal variable, for a relay coil 
that is output to the ServoWorks CNC Engine/ SMP Motion 
Engine, or a relay coil that is output to the machine tool) 

 
WRT.NOT (for a relay coil for an internal variable, for a relay 
coil that is output to the ServoWorks CNC Engine/ SMP Motion 
Engine, or a relay coil that is output to the machine tool) 

 AND 

 

OR 

  

Functional command of the LadderWorks PLC language.  
Symbols differ slightly depending on the kind of functional 
command.  

 
Left vertical power rail 

 
Right vertical power rail 

 Horizontal line connection 

 
Vertical line connection 

Table 8-2: Ladder Diagram Symbols for LadderWorks Console 
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8.3.6 Rungs/Rows  

The ladder diagram is composed of rows (or “rungs”). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-3: Ladder Diagram Rows 

8.3.7 Relay Junction Labeling 

The relay junction will contain the name of the relay coil and either the line number or the address of the signal.  
 
 
 
 
 
 
 
 
 

Figure 8-4: Format for Relay Junction Labeling in Ladder Diagrams 

8.3.8 Hardware-Based PLC Programming Compared to Software-Based PLC 
Programming 

In a usual hardware-based relay sequence circuit, the number of relay junctions is limited, so in order to minimize 
the number of relays, relays are reused within the circuit. 

 
 
 
 
 
 
 
 
 
 

Figure 8-5: Ladder Diagram Format for a Limited Number of Relays 

R2

R1

B

A 

Rung or row 

Power line 
Coil 

Contact point: signal, 
junction or relay 

Symbol Address 

Symbol Name

X  Double click here to edit label 

X  Double click here to edit address 
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In the LadderWorks PLC Engine, the number of relay junctions is not subject to the same hardware-based limits, so 
the ladder diagram is written with separate circuits (separate lines of code/separate rungs of the ladder diagram) as 
shown in the following figure.  The logic expressed is the same as above, but the ladder diagram PLC coding format 
is different.  
 

 
 
 
 
 

 

 

Figure 8-6: Ladder Diagram Format for LadderWorks Console Software-Based PLC 

8.4 Opening, Creating and Saving Ladder Diagrams 

To open a ladder diagram, select “Open…” from the “File” pull-down menu, as shown in the following figure: 
 

 
Figure 8-7: File Pull-Down Menu for Opening 

The following Open window will appear; locate the desired .ldv file, and click the “Open” button in the dialog 
window to open the ladder diagram file. 
 

 
Figure 8-8: Open the Ladder Diagram .ldv File 

R2

R1

B

A 

A 
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To create a new ladder diagram sequence program (at any time), select “New” from the “File” pull-down menu 
shown in Figure 8-7.  The ladder diagram display area will clear.  You should then save this empty file with a new 
name before you create your new sequence program. 
 
To save a ladder diagram, follow a similar procedure to opening a ladder diagram.  Select “Save” or “Save as…” 
from the “File” pull-down menu shown in Figure 8-7. 
 
A Save As window will appear, similar to the window shown in Figure 8-8; type in a file name for your sequence 
program.  The ladder diagram should be saved in the selected directory with the file extension “.ldv”; for example, 
“test01.ldv”.  Click the “Save” button in the dialog window to save the ladder diagram file. 

8.5 Creating and Editing Ladder Diagrams 

NOTE: Refer to Section 4.5 Coding Limitation – Horizontal Ladder Length of a PLC Sequence Program for 
limitations on horizontal ladder length. 

8.5.1 Inserting Basic Instruction Symbols  

8.5.1.1 Overview 
The main toolbar is shown in the following figure: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-9: Symbols for Creating PLC Components  

To insert basic instruction symbols [such as read (RD), read not (RD.NOT), write (WRT) and write not 
(WRT.NOT)], click the icon that corresponds to the desired basic instruction on the main toolbar shown above, 
position the mouse at the point you want to place the symbol, and click.  Enter an address with a label (such as 
“X2.1”), then press the “Enter” key. 
 
Specific information for each tool follows. 

Tools: 
Line Drawing 
Contact point 
Coil 
Comment 
Delete 
Select 
NOT 
OR 
OR 
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8.5.1.2 Using the Line Drawing Tool 

Use the    tool to draw a horizontal or vertical line connection.  When the    tool is selected (shown as 

 ), the first place you click will be the beginning of a line, and appears as follows: 
 

 
 
 
 

Figure 8-10: Beginning Point of Horizontal Line Connection 

The second place you click becomes the end point of the line, as shown:   
 

. 
 
 
 

Figure 8-11: Completed Horizontal Line Connection 

8.5.1.3 Using the Contact Point Tool 

When the    tool is selected (shown as  ), position the mouse at the point you want to place the symbol, 
and single click.  A cursor appears; enter an address with a label (such as "X2.1"), as show in the following figure: 
 

 

Figure 8-12: Entering the Address for a Contact Point  

Press the “Enter” key to confirm the input: the address will change to a normal display size, as shown in the 
following figure, and the corresponding label will appear as follows: 
 

 

Figure 8-13: Normal Display Size of the Input Label 
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NOTE: If you don’t enter an address and press enter, you will get an error message.  Also, you must input an address 
before you can change or add a label.  If you try to add a label before inputting an address, you will get an error 
message. 

8.5.1.4 Using the Coil Tool 

When the    tool is selected (shown as  ), position the mouse at the point you want to place the output 
coil, and single click.  A cursor appears; enter an address with a label (such as "G18.0"), and press the “Enter” key 
to confirm the input: the address will change to a normal display size, and the corresponding label will appear. 
 
NOTE: If you don’t enter an address, you will get an error message.  Also, you must input an address before you can 
change or add a label.  If you try to add a label before inputting an address, you will get an error message. 

8.5.1.5 Using the Comment Tool 
Comments MUST be placed only on empty rows.  (You may need to insert a row – see Section 8.5.5: Inserting 

Rows.)  When the    tool is selected (shown as  ), position the mouse at the point you want to place the 
comment, and single click.  A cursor appears; type in your comment text, as shown in the following figure:  
 

 
Figure 8-14: Entering a Comment 

Press the “Enter” key to confirm the input: the text will change to blue as shown in the following figure: 
 

 
Figure 8-15: Completed Comment 
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8.5.1.6 Using the Delete Tool to Delete Components 

When the    tool is selected (shown as  ), any component you click in the ladder diagram will be 
deleted.  (So be careful!  If you do make a mistake, though, you can select “Undo” from the “Edit” pull-down menu, 
OR press CTRL+Z.) 
 
See Section 8.5.4: Deleting Basic Instruction and Function Block Components for more information. 

8.5.1.7 Using the Select Tool to Select Components and Cut and Paste Components 

When the    tool is selected (shown as  ), you can select any contact point or coil component.  The 
Select tool doesn’t select horizontal or vertical lines, or comments. 
 
Once a component is selected, you can right click anywhere in the ladder diagram and select “Copy” or “Cut” from 
the drop-down menu that appears, as shown: 
 

 
Figure 8-16: Drop-Down Menu Available in Ladder Diagram Upon Right Clicking 

Or, when a component is selected, cut and copy tools appear in the main toolbar, as shown: 
 

 
 
 
 
 
 
 
 

Figure 8-17: Cut and Copy Tools in the Main Toolbar 

When a component has been cut or copied, you can paste that component by clicking at the desired location in the 
ladder diagram.  [NOTE: You don’t need to select “Paste,” and no “Paste” tool exists or is required.] 

Tools: 
Cut 
Copy 
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8.5.1.8 Using the NOT Tool to Create RD.NOT or WRT.NOT Components 
To create .NOT for relays and coils, there must be a selected relay or coil highlighted in yellow.  [You can use the  

  tool to select a relay (  ) or coil (  ).]  Single clicking the    tool changes a selected RD 

component (  ) to a RD.NOT component (  ), and vice versa: single clicking the    tool changes a 
selected RD.NOT component (  ) to a RD component (  ), 
 
So, in order to create .NOT for relays and coils, you will have to click multiple symbols on the main toolbar.   
 
As an example, the complete procedure for inserting a “RD.NOT” follows: 
 

1) Click the    tool, then click where you want to insert the relay.   
 

2) Type in the address, and hit the “Enter” key.  The newly created relay element will be highlighted after you 
hit the “Enter” key (  ). 
 

3) Click the   symbol.  The    element changes to .   
 

Use a similar procedure to create a  element (the  element +the   tool creates the  
element). 

8.5.1.9 Using the OR Tool 

To create OR constructions for relays, you must first use the    tool to select a relay (  ).  The selected 

relay will be highlighted in yellow.  Single clicking the    tool changes a selected relay component (  ) to 

an OR component (  ), and allows you to enter the address for this new relay in the OR component.  

[NOTE: Clicking the    tool subsequent times adds more relay elements to the OR component.] 
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To create OR constructions for coils, you must first use the    tool to select a coil (  ).  The selected coil 

will be highlighted in yellow.  Single clicking the    tool changes a selected coil component (  ) to an 

OR component (  ), and allows you to enter the address for this new coil in the OR component.   

[NOTE: Clicking the    tool subsequent times adds more coil elements to the OR component.] 

8.5.2 Inserting Function Block Components 

Insert function block components such as TMR, TMRC, MOVE, and DEC with the following steps: 
 

1) Select the desired function block component from the “Function” pull-down menu in the upper right corner 
of the screen, as shown in the following figure: 

 

 

 Figure 8-18: Function Block Components Pull-Down Menu  

2) Position the mouse at the point you want to place the component, and click. 
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3) Enter the parameters for the function block component.  For function block components with multiple 
parameters, a Parameter Edit Dialog box will appear, as shown in the following example:  

 
 
 
 
 
 
 
 
 
 

 

 Figure 8-19: PLC Function Parameters Input Box – Entering Parameter Values  

4) For function blocks with multiple parameters, a pull-down menu will appear where you can select each 
parameter.  Input the parameter values one by one in the parameter value box right next to the parameter 
name box, as shown in the following figure:  
 

 

Figure 8-20: PLC Function Parameters Input Box – Selecting Parameter Name  

NOTE: If the format of the parameter you input is incorrect (in the wrong form or in an unacceptable range), you 
will get an error message similar to the following: 
 

 
Figure 8-21: Parameter Setting Error Message 

Enter values for parameters 
in this text box 

Pull-down menu for 
multiple parameters 
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8.5.3 Modifying Basic Instruction and Function Block Components 

To modify a basic instruction or function block component, position the mouse cursor on the desired basic 
instruction or function block component, and double click the input line, as shown in the following figure:  
 
 
 
 
 
 
 
 
 

 Figure 8-22: Modify Parameters by Double Clicking the Input Line  

For basic instruction components, a cursor will appear and the user will be able to edit the address.  
 
For function block components, the Parameter Edit Dialog box will appear, and you will be able to modify the 
parameters of the function block in the same manner that you entered the parameters originally. 

8.5.4 Deleting Basic Instruction and Function Block Components 

You can delete basic instruction and function block components with the following steps: 
 

1) Click the    icon on the main toolbar shown in Figure 8-9. 
 

2) Position the mouse at the desired basic instruction symbol or function block component. 
 

3) Double click the line, symbol or component to be deleted. 

Double click  
this line 
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Figure 8-23: Example: Deleting a Component  

8.5.5 Inserting Rows 

Position the mouse cursor on a basic instruction symbol, function block component, or relay coil in a row adjacent to 
where you want to insert a new row.  Then select either “Insert Row Before” or “Insert Row After” from the “Edit” 
pull-down menu (as shown in the following figure), depending on where you want the new row to be located. 
 

 
Figure 8-24: Edit Pull-Down Menu for Inserting/Deleting Rows 

To delete the TMRB function shown, 
click here first…. 

….then click 
this line 
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8.5.6 Deleting Rows 

Position the mouse cursor on a basic instruction symbol, function block component, or relay coil in the row you 
want to delete.  Then select either “Delete Row” from the “Edit” pull-down menu (as shown in the previous figure). 

8.6 Searching the Ladder Diagram for an Address or Label 

Select “Find…” from the “Edit” pull-down menu, as shown in the following figure: 
 

 

Figure 8-25: Edit Pull-Down Menu for Exporting Mnemonic Code  

A Direction window will appear, as show in the following figure: 
 

 

Figure 8-26: Direction Dialog Box for Searching the Ladder Diagram   

Type the search text in the “Search for:” text box, select the direction to search (up or down), and click the “Find 
Next” button.  The ladder diagram automatically scrolls to display the first instance of matching text for an address 
or label for a component, and that component is highlighted in yellow. 
 
LadderWorks Console finds the exact, whole word that you have typed in – only a match for an exact address or 
label would return a result, not partial addresses or labels.  For instance, if you specify “0.0” in the text box, 
LadderWorks Console would not consider “X0.0” a match. 
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8.7 Printing the Ladder Diagram 

Select “Print Setup…” from the file menu to set your print settings (printer, paper size, etc.).  Then select “Print” 
from the “File” pull-down menu, as shown in the following figure: 
 

 

Figure 8-27: Selecting Print from the File Menu  

LadderWorks Console will print the entire ladder diagram. 

8.8 Changing Between the Ladder Diagram View and the Instruction List 
View 

The same sequence code program can be viewed in both Ladder Diagram (LD) graphical view and Instruction List 
(IL) text view.  However, the sequence code program cannot be edited in Instruction List format in LadderWorks 
Console.   
 
Click on either “Ladder View” or “Instruction List View” at the left of the screen to change the PLC sequence code 
format, as shown: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8-28: Selecting Ladder View, Instruction List View or Register Address Map 

The Instruction List view looks similar to the following window: 
 

Select the view (sequence code 
format) you want: Ladder View or 

Instruction List View 
 

Select this to view F, G, X and Y 
I/O mapping 
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Figure 8-29: Instruction List View 
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8.9 Viewing the Register Address Map 

The F, G, X and Y addresses in the register address map can be viewed and the descriptions can be edited by 
selecting “Register Address Map” at the left of the screen, as shown in Figure 8-28.  The display changes to 
something similar to the following window: 
 

 
Figure 8-30: Register Address Map View 

A sample address table is provided.  You can set user-defined descriptions on any desired existing PLC I/O 
component, by double clicking on an address, label or description, highlighting the text, and typing the new text. 
 
To insert a new address, right click within the table, and a drop-down menu will appear, as shown in the following 
figure: 
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Figure 8-31: Insert/Delete Drop-Down Menu in Register Address Map View 

If you select “Insert,” the following pop-up window will appear: 
 

 
Figure 8-32: New Address Pop-Up Window for Inserting Addresses in the Registry 

Fill in the text boxes, and click “OK” to add a new I/O address. 
 
To delete an address, click on that address, right click within the table, and select “Delete” from the drop-down 
menu shown in Figure 8-31. 
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8.10 Importing a PLC Sequence Program File in Instruction List (IL) Format 

To import an existing PLC sequence program code that exists in Instruction List (IL) format, select “Import 
Mnemonic Code” from the “File” pull-down menu as shown in the following figure: 
 

 
Figure 8-33: File Pull-Down Menu for Importing the Existing Sequence Program Code 

An “Open” window will appear as shown below; locate and select the desired .lad file containing the PLC sequence 
program code, and click the “Open” button.  
 

 
Figure 8-34: Open Window – Selecting the Sequence Program File to Import 

The ladder diagram corresponding to the selected sequence program code will appear in LadderWorks Console 
(Ladder View) if the importing is successful, as shown in the following figure: 
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Figure 8-35: Ladder Diagram Imported From an Existing Sequence Program Code 
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8.11 Exporting PLC Sequence Program Code in Instruction List (IL) Format 
(.mod and .lad Files) 

To export a PLC sequence program in Instruction List (IL) format (from ladder diagram format), select “Export 
Mnemonic Code” from the “File” pull-down menu, as shown in the following figure: 
 

 

Figure 8-36: File Pull-Down Menu for Exporting Mnemonic Code  

A Save As window will appear, as show in the following figure: 
 

 

Figure 8-37: Save As Window for Saving the .mod File 

With this function, LadderWorks Console can export the sequence program code generated according to the ladder 
diagram created in the editing window. The sequence code will be exported as a “.lad” file in the selected directory, 
together with a “.mod” file bearing the same file name as the “.lad” file.   [See Section 4.2: Sequence Program File 
Types.] 
 
You just need to type in a file name (for example, “SoftServoPLC”) in the Save As window in the above figure for 
the “.mod” file, and save it to the selected directory (usually it should be saved in the directory “C:\SwPLC\Ladder”, 
but you can save these files in any folder you want). The corresponding “.lad” file (in the case of 
SoftServoPLC.mod, it would be SoftServoPLC.lad) will be saved to the same directory automatically. 
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After saving the “.mod” file to the directory “C:\SwPLC\Ladder”, two files will be created in that directory, one of 
them is “.mod” file such as “test01.mod”, and the other is “.lad” file with the same file name such as “test01.lad”. 

8.12 Compiling a Ladder Diagram (LD) Sequence Program (Generating 
Executable Binary Code – .bin, .fig, .lad, .lst and .mod Files) 

To generate the executable binary code according to the ladder diagram, select “Generate Binary Code” from the 
“File” pull-down menu, as shown in the following figure: 
 

 
 

Figure 8-38: File Pull-Down Menu for Generating Executable Binary Code 

A Save As window will appear, as shown in the following figure; type in the desired file name with the extension 
“.bin,” such as “SoftServoPLC.bin”, and then click the “Save” button. 
 

 
Figure 8-39: Save As Window for Saving the Binary Code File 

        

The filename of ".mod" file should not contain any spaces, meaning “test  01.mod” is 
not allowed.  Otherwise, the compiler won't work properly. (You can use 
“test_01.mod” instead.) 

                                         CAUTION ! 
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Five files will be created with the same file name but with different file extensions, in the same folder: .bin, .fig, 
.lad, .lst and .mod files.  [See Section 4.2: Sequence Program File Types.]  You can save these files in any folder 
you want.  (The LadderWorks PLC Engine stores the location of the most recently created .bin file.)  If the 
generation of binary code is successful, and a message window will appear as shown in the following figure: 
 

 
Figure 8-40: Message Window Showing a Successful Binary Generation 

8.13 Verifying and Monitoring PLC in Diagnostic Mode 

8.13.1 Overview 

In Diagnostic Mode, LadderWorks Console displays the execution of PLC sequence programs by the LadderWorks 
PLC Engine, which operates in the real-time subspace created by Ardence RTX.  The LadderWorks PLC Engine is 
completely integrated with either the ServoWorks CNC Engine or the SMP Motion Engine (depending upon 
whether you are using a ServoWorks CNC product or an SMP general motion control product).  The LadderWorks 
PLC Engine and the ServoWorks CNC Engine/SMP Motion Engine perform the critical functions necessary for 
motion control, and are given the highest priority by the computer's CPU. 

8.13.2 Using Diagnostic Mode (On-Line Mode) 

To start Diagnostic Mode, select “Diagnostic Mode” from the “OnLine” pull-down menu, as shown in the following 
figure: 
 

 
 

Figure 8-41: OnLine Pull-Down Menu for Starting Diagnostic Mode 

In Diagnostic Mode, components whose value is “ON” or “1” are shown as green.  Components whose value is 
“OFF” or “0” are shown as blue.  A selected component is shown as highlighted in yellow.  See the following 
figure: 
 



 LADDERWORKS PLC USER’S MANUAL 
 Chapter 8:  Using LadderWorks Console 

_____________________________________________________________________________________ 
8-26 

 
Figure 8-42: LadderWorks Console Diagnostic Mode 

When a component’s signal value changes (from “0” to “1” or from “1” to “0”), that component flashes. 

8.13.3 Disabling and Enabling Devices 

While in Diagnostic Mode, you can disable a device (component), so that device becomes like a comment.   
 
First select the device to disable, then select “Disable device” from the “Edit” pull-down menu. 
 

 
Figure 8-43: Edit Pull-Down Menu for Disabling a Device 

A disabled device becomes dashed, as shown in the following figure: 
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Figure 8-44: LadderWorks Console – Disabled Device in Diagnostic Mode 

You can select and enable a disabled device in the same way. 

8.13.4 Forcing Component Values While Monitoring Sequence Programs 

LadderWorks Console allows you to force component values while monitoring sequence programs.  This is helpful 
in diagnosing problems during machine setup and integration. 
 
When you overwrite a value for an F, R or D address, the LadderWorks PLC Engine stops reading the “real” value, 
and substitutes the overwritten value.   
 
NOTE: This feature is only available for F, R and D addresses.   
 
To force a value for a component, and see its effect on PLC sequence program execution, select “Overwrite” from 
the “OnLine” pull-down menu, as shown in the following figure: 

Disabled device 
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Figure 8-45: OnLine Pull-Down Menu for Overwriting a Component’s Value 

An Online Overwrite window appears, as shown in the following figure: 
 

 
Figure 8-46: Online Overwrite Window 

Select the address letter, the data type, and fill in the address, bit offset and new value, then click the “OK” button. 

8.13.5 Restarting Diagnostic Mode 

When you make changes to a sequence program during Diagnostic Mode, you must generate a new binary code [see 
Section 8.12: Compiling a Ladder Diagram (LD) Sequence Program (Generating Executable Binary Code – .bin, 
.fig, .lad, .lst  and .mod Files)], then you must restart Diagnostic Mode in order to see the execution of the newest 
PLC sequence code. 
 
If you make changes to a sequence program during Diagnostic Mode, and you DON’T restart Diagnostic Mode, the 
display of sequence code execution is misleading.  LadderWorks Console is not executing the ladder diagram you 
see on the screen; it is executing the ladder diagram as it was the last time you generated a new binary code and 
restarted. 
 
 
 
 
 
 
 
 
 
 

        

CHANGES YOU MAKE IN THE LADDER DIAGRAM WILL NOT BE 
REFLECTED IN DIAGNOSTIC MODE UNTIL YOU GENERATE A NEW 
BINARY CODE AND RESTART ONLINE MODE. 

                                         CAUTION ! 
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8.14 Closing a Sequence Program 

Select “Close” from the “File” pull-down menu.  A pop-up window will appear, as shown in the following figure: 
 

 
Figure 8-47: Confirm Closing Sequence Program Dialog Box 

Click “Yes” to save and close the .ldv file. 

8.15 Exiting LadderWorks Console 

By selecting “Exit” from the “File” pull-down menu, you can exit LadderWorks Console, as shown in the following 
figure: 

 
Figure 8-48: File Pull-Down Menu for Closing LadderWorks Console 

A dialog box may appear, similar to Figure 8-47.  Click “Yes” to save the sequence program file before closing the 
application, or click “No” to exit the application without saving the sequence program file. 
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8.16 LadderWorks Console Automatically Shutting Down 

 If LadderWorks Console is running concurrently with another Soft Servo Systems application (such as ServoWorks 
MC-Quad, ServoWorks S-140M or SMP400), closing that other application will automatically shut down the 
LadderWorks Console application, due to the need to stop the Ardence RTX real-time extension to the operating 
system (that is interfacing with both LadderWorks Console and the other Soft Servo Systems application).  [If 
LadderWorks Console didn't shut down when the other Soft Servo Systems application shut down, there would be 
errors with Ardence RTX upon trying to restart the other Soft Servo Systems application.] 
 
LadderWorks Console provides a dialog box that allows you to save your PLC sequence program before it closes.  
You will see a dialog box similar to the following: 
 

 
Figure 8-49: LadderWorks Console Automatic Closing Dialog Box 

This affords you the opportunity to save any changes to your PLC sequence program before the LadderWorks 
Console shuts down. 
 
NOTE: When LadderWorks Console is the only Soft Servo Systems application running, it will not close down 
automatically.  
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Chapter 9:  Using the PLC Bit Pattern Utility 

The PLC Bit Pattern utility shows the PLC byte data in binary format.  You can see the 8-bit address in a byte 
address that you specify. 
 
Start the PLC Bit Pattern utility by double clicking on the  file in C:\SwPLC.  You will 
see the Bit Pattern window shown in the following figure: 
 

 
Figure 9-1: Bit Pattern Window 

Type in a byte address, click the “Start” button, and you will see the current bit pattern. 
 
For example, let’s say you type in the address “x12,” click on the “Start” button, and see the bit pattern “11101110,” 
as shown: 
 

 
 
In this case, the data is showing from the left side: 
 
 
  
 
 
 
 
 
 
 

x12.7        x12.6        x12.5        x12.4        x12.3        x12.2       x12.1        x12.0 

Figure 9-2: Bit Pattern Explanation 

Therefore, the “ON” bits are the following six values: x12.7, x12.6, x12.5, x12.3, x12.2, and x12.1. 
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Chapter 10:  Using the PLC Time Chart Utility 

 
The PLC Time Chart Utility can show PLC internal data as a time chart.  
 
Start the PLC Time Chart utility by double clicking on the  file in C:\SwPLC.  You will 
see the PLC Time Chart window shown in the following figure: 

 

 
Figure 10-1: Time Chart Window 

The following steps will guide you in using the PLC Time Chart Utility: 
 

1) Input the address(es) for which you need to see the status. 
 
2) At the right side of the window, set up the sampling interval by selecting the time in milliseconds. 
 
3) Click on the “Start” button, and you will see the ON/OFF status in the center of the screen.  During the 

sampling, you can change the sampling intervals by changing interval time. 
 
4) Click on the “Stop” button to stop the sampling.  

 
At any time, you can click on the “Clear” button to clear the window and delete the graph(s). 
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Chapter 11:  Verifying Sequence Programs Using the LadderWorks 
PLC Diagnose Utility 

11.1 Overview of the PLC Diagnose Utility 

This utility shows the status of an executing PLC sequence program as a ladder diagram circuit in real time.  By 
monitoring the real-time status of contacts, you can verify that you have properly set up your PLC sequence program 
for your machine. 
 
The PLC Diagnose utility only displays the currently executing sequence program.  You cannot choose which 
sequence program to display in ladder diagram format. 
 
NOTE: The PLC Diagnose utility is legacy software.  Its use is explained here for completeness, since it is still 
included in LadderWorks PLC.  However, we recommend using the more functional LadderWorks Console, 
explained in Chapter 7: Using LadderWorks Console, which not only allows you to monitor real-time execution of 
your PLC sequence program, but also to create, import, edit, compile and print sequence programs. 

11.2 Using the PLC Diagnose Utility 

The following steps will guide you in using the LadderWorks PLC Diagnose utility: 
 

1) Start the PLC Diagnose utility by double clicking on the  file in C:\SwPLC.  You 
will see the PLC Diagnose window shown in the following figure: 

 

 
Figure 11-1: PLC Diagnose Window 
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2) Click on “Module selection” from the menu, and you will see the window shown in the following figure: 
 

 
Figure 11-2: Module Selection Window 

3) Only the currently executing sequence program module will be available for selection.  Select that module, 
and click the “OK” button.  A ladder diagram window will appear for that module, similar to that shown in 
the following figure: 
 

 
Figure 11-3: PLC Diagnose Window with Comments for an Example Module 

Signals shown in bold indicate a value of “ON” or “1.”  While the PLC Diagnose utility is running, signals flash 
when they change value (from “0” to “1” or from “1” to “0.”) 
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11.3 Ladder Diagram Format (Interpreting the Ladder Diagram)  

11.3.1 Overview 

The ladder diagram is interpreted by you.  There is a set of consistent symbols described below.  The ladder diagram 
will contain addresses, signal names, and comments. 

11.3.2 Addresses 

An address is composed of an address number and a bit number, as described in the following figure: 
 

 
 
 
 
 
 

Figure 11-4: Format for an Address in a Ladder Diagram 

There is always a letter of the alphabet in front of the address number to indicate the kind of signal it is.  See the 
following table for letters used and their meanings.  

 

Signal Letter Signal Description 

X Input signal from the machine to the LadderWorks PLC Engine  
(MT → PLC) 

Y Output signal from the LadderWorks PLC Engine to the machine  
(PLC → MT) 

F Input signal from the ServoWorks CNC Engine / SMP Motion Engine 
(NC) to the LadderWorks PLC Engine (NC → PLC) 

G Output signal from the LadderWorks PLC Engine to the ServoWorks 
CNC Engine / SMP Motion Engine (NC) (PLC → NC) 

R Internal Relay 

A Requesting Message Display 

C Counter 

K Keep Relay 

D Data Table 

T Variable Timer 

Table 11-1: Signal Letters and Their Meanings 

R 202.2 

Bit number (0~7) 

Address number (up to 4 digits following a letter 
– the address ranges vary for each signal) 

Signal letter 
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11.3.3 Signal Names 

All signal names will be at most 8 characters.  Each character can be a letter, a number, or a special symbol.  

11.3.4 Commenting 

Up to 30 characters may be displayed to comment each relay coil and signal in the sequence program. 

11.3.5 Symbols 

The ladder diagram utilizes the following symbols:  
 

 

Symbol Description 
  

 Ajunction   

 Bjunction 

Relay (for an internal variable) 
inside of the LadderWorks 
PLC Engine 

 Ajunction   

 Bjunction 

Input signal from the 
ServoWorks CNC Engine/ 
SMP Motion Engine 

 Ajunction   

 Bjunction 

Input signal from the machine 
tool 

 

contact signals 

 

 

Relay coil used only inside the 
LadderWorks PLC Engine (for 
an internal variable) 

 

 

Relay coil that is output to the 
ServoWorks CNC Engine/ 
SMP Motion Engine 

 

 

Relay coil that is output to the 
machine tool 

 

coils 

Table 11-2: Ladder Diagram Symbols for the PLC Diagnose Utility (1 of 2)  
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Symbol Description 

 

Functional command of the 
LadderWorks PLC language.  
Symbols differ slightly 
depending on the kind of 
functional command.  

 
Left vertical power rail 

 
Right vertical power rail 

 
Horizontal line connection 

 

Vertical line connection 

Table 11-3: Ladder Diagram Symbols for the PLC Diagnose Utility (2 of 2)  

11.3.6 Rungs/Rows  

The ladder diagram is composed of rows (or “rungs”).  NOTE: Refer to Section 4.5 Coding Limitation – Horizontal 
Ladder Length of a PLC Sequence Program for limitations on horizontal ladder length. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11-5: Ladder Diagram Rows 

Rung or row 

Power line 
Coil 

Contact point: signal, 
junction or relay 
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11.3.7 Relay Junction Labeling 

The relay junction will contain the name of the relay coil and either the line number or the address of the signal.  
 
 
 
 
 
 
 
 

Figure 11-6: Format for Relay Junction Labeling in Ladder Diagrams 

11.3.8 Hardware-Based PLC Programming Compared to Software-Based PLC 
Programming 

In a usual hardware-based relay sequence circuit, the number of relay junctions is limited, so in order to minimize 
the number of relays, relays are reused within the circuit. 

 
 
 
 
 
 
 
 
 
 

Figure 11-7: Ladder Diagram Format for a Limited Number of Relays 

In the LadderWorks PLC Engine, the number of relay junctions is not subject to the same hardware-based limits, so 
the ladder diagram is written with separate circuits (separate lines of code/separate rungs of the ladder diagram) as 
shown in the following figure.  The logic expressed is the same as above, but the ladder diagram PLC coding format 
is different. 
 

 
 
 
 
 

 

 

Figure 11-8: Ladder Diagram Format for the Software-Based PLC Diagnose Utility 

Symbol Address 

Symbol Name 

R2

R1

B

A 

R2

R1

B

A 

A 
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11.4 Changing the Display of the PLC Diagnose Utility 

You can click on the    symbol in the upper right hand corner of the window to maximize the window, or use the 
scroll bar to scroll through the complete display.  
 
You can also click on “Display” from the menu and uncheck the “Comment display”, as shown in the following 
figure: 
 

 
Figure 11-9: Changing the Comment Display 

This will hide the comments (descriptions) and make the display more condensed, as shown in the following 
window:   
 

 
Figure 11-10: PLC Diagnose Window Without Comments for an Example Sequence Program 
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11.5 Using the Search Function of the PLC Diagnose Utility 

Click on “Search” from the menu in the PLC Diagnose window, and you will see the window shown in the 
following figure: 

 
Figure 11-11: PLC Diagnose Search Window 

To scan for an address in the PLC Diagnose Window, type the address you want to find in the “Search address” text 
box.  You can search for a contact point, or a coil, or both.  Click on either “Search upward” or “Search downward” 
buttons – if the address exists, the first instance of it will be highlighted in the PLC Diagnose window. 

11.6 Exiting the PLC Diagnose Utility 

Select “Exit” from the “Display” pull-down menu, as shown: 
 

 
Figure 11-12: Selecting “Exit” from the “Display” Pull-Down Menu 

The PLC Diagnose utility will terminate. 
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Chapter 12:  Troubleshooting 

12.1 The PLC won't start or does not work correctly.  How can I restore it? 

Please use the following steps to recover PLC and put the settings back to the default settings.  [NOTE: An 
uninstall/reinstall procedure doesn’t help, because it doesn’t reset parameters.] 
 

1) Check the PLC service:  
 
• For Windows 2000, go to "Start"  "Settings"  "Control Panel"  "Administrative Tools"  

"Services"  "swplc_link" 
 

• For Windows XP, go to "Start"  "Settings"  "Control Panel"  "Administrative Tools"  
"Services"  "swplc_link" OR "Start"  "Control Panel"  "Administrative Tools"  "Services"  
"swplc_link" 
 

2) If the status is not started, run C:\SwPLC\Service\swplclink_service_remove.bat, then run 
C:\SwPLC\Service\swplclink_service_install.bat 
 

3) Run C:\SwPLC\SwPLC.reg [NOTE: You will lose all timer settings, keep relay settings, etc.  You can skip 
this step to keep your settings.] 
 

4) Recompile: run c:\swPlc\Utility\swPLC_CONTROL.exe, and click the "Compile" button in the PLC 
Control Screen.  Click the “Refer” button in the screen that appears, browse to the C:\SwPLC\Ladder” 
folder, choose the proper module (.mod file), then click the “Open” button.  Click the “Compile execute” 
button.  You will see the “Compile Success” message.  Click “Cancel,” and close the PLC Control Screen. 

12.2 The PLC didn't work.  How can I check that the PLC service is 
running? 

You can check as follows: 
 

1) Check the PLC service:  
 
• For Windows 2000, go to "Start"  "Settings"  "Control Panel"  "Administrative Tools"  

"Services"  "swplc_link" 
 

• For Windows XP, go to "Start"  "Settings"  "Control Panel"  "Administrative Tools"  
"Services"  "swplc_link" OR "Start"  "Control Panel"  "Administrative Tools"  "Services"  
"swplc_link" 
 

2) If the status is not started, run C:\SwPLC\Service\swplclink_service_remove.bat, then run 
C:\SwPLC\Service\swplclink_service_install.bat.  

12.3 When I started PLC_DIAGNOSE, it shows me a black screen.  What 
should I do? 

Please run C:\SwPLC\SwPLC_Diagnose_Color.reg. 
 
The "SwPLC_Diagnose_Color.reg" file is to set PLC_DIAGNOSE to its default settings when it doesn't operate 
correctly.   
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12.4 The TMRC command for PLC didn't work.  

When the TMRC (timer) command is used in a PLC sequence program, you must set the table with the "D Table" 
button of swPLC_CONTROL.  See Section 6.6: Setting Up and Editing Data Table Addresses. 

12.5 How can I disable the pulse generator with the PLC sequence 
program? 

1) Open "C:\SwPLC\Ladder\SoftServo_0.lad" file with any text editor.  Replace one line of code: 
 

// E-Stop using HandWheel E-Stop input 
"RD X0.0" 

 
 

2) Save the file and start "C:\SwPLC\Utility\swPLC_CONTROL.exe" 
 

3) Click the "Compile" button and make sure the "Module definite file name" is 
"C:\SwPLC\Ladder\SoftServo_0.mod" and click "Compile execute"; you will see a "Compile success" 
message. 
 

4) Click "Cancel" to close the PLC control screen. 

12.6 The PLC Diagnose utility cannot load my sequence program. 

This phenomenon occurs when neither the PLC service nor other processing is being correctly done.  Check that the 
PLC service is running correctly or put the settings back to the default settings (as explained in previous sections).  

12.7 I can't stop PLC with the PLC Control Screen utility.  What is going on? 

This phenomenon occurs when neither the PLC service nor other processing is being correctly done. Check that the 
PLC service is running correctly or put the settings back to the default settings (as explained in previous questions).  

12.8 The PLC didn't start correctly with my customized application; what's 
wrong? 

The PLC function calls must be in the following order: 
 

• sssStartInterrupt(HD) 
 

• Plc_ini_start(PLC_setdata) 
 

• sssPLC_Start(HD, PLC_setdata) 

 

Change this line to become 
"RD.NOT X0.0" 
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12.9 I am using LadderWorks Console, and the "Diagnostic Mode" option in 
the OnLine pull-down menu isn't available – it appears grayed out. What is 
going on? 

It could be one of three things: 
 

1) Are you using the On-Line version of LadderWorks Console on a PC on which Ardence RTX is not 
installed? Ardence RTX must be properly installed before the LadderWorks Console On-Line version is 
installed. 
 

2) Are you using the On-Line version of LadderWorks Console on a PC that has no adapter card installed?  
An adapter board for VersioBus, Panasonic Realtime Express (RTEX), MECHATROLINK or SSCNET 
must be installed. 
 

3) Is your ServoWorks CNC or SMP software compatible with LadderWorks Console?  See page 1-2 for 
compatibility requirements. 

12.10 Using G100, I am trying to move Axis 4, but cannot move.  However, if 
I try to move Axis 5, I could move Axis 4. What’s going on? 

Please refer to Table 4-10 on page 4-6 of the LadderWorks PLC I/O Mapping for ServoWorks MC-Quad and the 
ServoWorks S-100M Series. 

12.11 Through PLC (using G10 and G11), I could only set up the value of 
the Jog Feedrate Override (Manual Feedrate Override) up to 24,576 
[mm/min].  Why? 

The value of Jog Override faces restrictions on Feedrate according to the following parameters: 
 

1) Jog Feedrate Override [mm/min or deg/min] (under Spindle Tab in Config) 
 

2) Rapid Override [mm/min or deg/min] (under Spindle Tab in Config) 
 

3) Rated Velocity [RPM] (Motor/Drive Tab in Config) 
 

4) Peak Velocity [RPM] (Motor/Drive Tab in Config) 
 

5) Distance Per Encoder Revolution [mm or deg] (Axis Control Tab in Config) 
 
Suppose, for instance, Rated Velocity is 3000 [RPM] and Distance Per Encoder Revolution is 8.192 [mm/RPM], the 
maximum speed would be 24,576 [mm/min] in this case (3000 x 8.192). 
 
As an actual speed calculation, if G10.7 is set to 0, which corresponds to a weight of 128, and Jog Feedrate is set to 
10,000, the calculated speed is 10,000 x 1.28 = 12,800 [mm/min].  
 
If you use an incremental motor whose maximum rated velocity (Rated Velocity) is 3000 [RPM] and set Distance 
Per Encoder Revolution to 16.384 [mm/RPM], in this case, the Jog override value will be 49,152 [mm/min] (3000 x 
16.384).  
 
Therefore, please check to see whether or not these parameters restrict the velocity of Jog Feedrate Override. 
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Please refer to Table 4-4 on page 4-6 of the LadderWorks PLC I/O Mapping for ServoWorks MC-Quad and the 
ServoWorks S-100M Series. 

12.12 We created a customized PLC sequence program for our ServoWorks 
CNC system, but there are some input bits that are not stable.  After much 
checking, we have changed to other inputs, and now it works.  Please 
advise. 

There are certain I/O points (X/Y) and internal relay (R) addresses that are already used in the default LadderWorks 
PLC sequence program provided with your ServoWorks CNC or SMP product.  Please read and fully understand the 
default PLC sequence program.  If certain I/O addresses are already used, please modify the default sequence 
program and reuse the code, or avoid those used addresses completely.  
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